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About Hyperion System 9
Hyperion® System™ 9 is a comprehensive Business Performance Management (BPM) system
that consists of these products:

● Hyperion® System™ 9 Workspace™—Management reporting including query and analysis
in one coordinated environment

● Hyperion® System™ 9 Application Builder.NET™—Coordinated planning, consolidation,
and scorecarding applications

● System 9 Foundation Services™ —Used to ease installation and configuration, provide
metadata management, and support a common Microsoft Office interface
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About Workspace
Workspace is a DHTML-based, zero-footprint client that provides the user interface for viewing
and interacting with content created using Hyperion® System™ 9 BI+™ authoring studios and
financial applications:

● Enterprise metrics for management metrics and analysis presented in easy-to-use,
personalized, interactive dynamic dashboards

● Financial reporting for scheduled or on-demand highly formatted financial and operational
reporting from most data sources including Hyperion® System™ 9 Planning™ and
Hyperion® System™ 9 Financial Management™

● Interactive reporting for ad hoc relational queries, self-service reporting, and dashboards
against ODBC data sources

● Production reporting for high volume enterprise-wide reporting

● Web analysis for interactive ad hoc analysis, presentation, and reporting of
multidimensional data

● High performance multidimensional modeling, analysis, and reporting with Hyperion®
System™ 9 BI+™ Analytic Services™

BI+, which includes Analytic Services, is part of a comprehensive BPM system that integrates
the business intelligence platform with financial applications, Hyperion® System™ 9 Smart View
for Office™, and Hyperion® System™ 9 Performance Scorecard™.
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Workspace User Interface
When you log on, the default Workspace start page is displayed. The default is set from the
Preferences dialog, “Setting Preferences” on page 27.
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Table 2 Workspace Elements 

Number Name Description

1 Menu Bar Commands and sub-commands that organize tasks and modules (See “Menus” on page
48)

2 Standard toolbar Buttons for performing tasks (See “Toolbars” on page 44.)

3 View pane Area that provides buttons that enable jumps between panels (each panel having a
specific use and corresponding controls) and displays the list of documents and modules
(Hiding this pane provides a larger content frame in which to use Workspace. Select
View > View Pane to hide and display).

4 View Pane or Content Area Adjuster Setting to adjust the size of the View pane and content area

5 Content area Area in which you view active-module documents, tasks, or files

6 Buttons Buttons for performing module tasks

7 Process bar Location of the current folder, document, or step.

8 Document tab bar Information bar specific to the current module (If multiple documents are open, the
current document tab is highlighted).
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Setting Preferences
As a designer, you can set defaults for the general appearance of Workspace user interface,
Explore, studios, and authentication for changing user passwords. Preferences for Planning are
not set from Workspace. For Planning end-user preference settings see the Hyperion System 9
Planning User's Guide and for administrator and application preferences, see the Hyperion System
9 Planning Administrator's Guide. Financial Management preferences are set from the
Workspace, see “Setting User Preferences for Financial Management” on page 69. Default
startup options can be set for the View pane and content area. Some settings can be overridden
through menu options. See Chapter 2, “Setting Preferences and Personalizing Your
Workspace”.
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Note:

Your e-mail address, which you cannot update, defaults to the e-mail address registered in your
user security settings.
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Showing Bar Values

➤ To toggle the display of values, select a bar and choose Show Bar Values on the shortcut menu.

Scatter Charts
A scatter chart is useful for emphasizing scientific or statistical similarities rather than differences
in your analysis. Scatter charts illustrate the relationship between pairs of numerical or
quantitative values, which are combined into individual data points along the horizontal (y axis)
and a vertical (x axis) axis. Data points are plotted in uneven intervals.

A scatter chart represents non-aggregated sources, that is, it retrieves data from the underlying
Table/Reports section and does not reflect rolled up values (all other chart types retrieve their
data from an aggregated source, and there is a one-to one correspondence between Charts and
Pivots). For this reason, the Pivot This Chart feature is not available for a scatter chart.

Scatter charts can only contain a pair of fact or numeric values which are placed in the Y Axis
and X Axis in the data layout. If you add only one fact item to the data layout, no scatter chart
is rendered. In addition, label values cannot be added to the Y Axis or X Axis of the data layout.

The following feature limitations apply to scatter charts:

● Data functions are not available to scatter charts because this type of chart relies on non-
aggregated data.

● The sort feature cannot be used for scatter chart items.

● The Pivot To Chart feature is not available.

● Drilling cannot be performed on a scatter chart.

● The focus feature cannot be used on scatter chart items.

● The Hide feature hides the whole data series in a scatter chart, and an individual item cannot
be hidden.

Bubble Charts
Bubble charts are typically used to show three dimensions of data in a two dimensional chart.
This type of chart often lends itself to the display of financial data because specific values can be
visually represented in your chart by different bubble sizes. It is similar to scatter chart allowing
you to plot data as a collection of bubbles. Bubble charts plot three values:

● a value set on the x-axis

● a value set on the y-axis

● a value that defines the size or width dimension of a bubble in proportion to the amount of
data

Multiple data values can be plotted in the bubble chart.

Bubbles with zero size can rendered using some small bubble size to prevent them from
disappearing. Also there is an option can be provided to hide zero-size values if necessary.
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Bubbles with negative values can also be displayed. These type of values are derived from their
real absolute value, and the real negative value is depicted in the data label (although based on
the positive value). You can optionally select not to show negative values.

The following feature limitations apply to bubble charts:

● Data functions are not available to bubble charts because this type of chart relies on non-
aggregated data.

● The sort feature cannot be used for bubble chart items.

● The Pivot To Chart feature is not available.

● Drilling cannot be performed on a bubble chart.

● The focus feature cannot be used on bubble chart items.

● The Hide feature hides the whole data series in a bubble chart, and an individual item cannot
be hidden.

➤ To create a bubble chart:

1 In the Section pane, select the chart in which to generate the bubble chart.

2 Drag a fact value from the Catalog pane to the Y Axis of the data layout.

3 Drag a fact value from the Catalog pane to the X Axis of the data layout.

4 Drag a fact value from the Catalog pane to the Size pane of the data layout.

➤ To show the real value of a data point, use the tool tip and hover over the data point.

➤ To show grid lines on the scatter chart, click the plot area of the chart and select Show X Axis Grid
Lines or Show Y Axis Grid lines.

Multidimensional Chart Types
Frequently you may want to view data represented in more than two dimensions. For example,
you may want to see how the sales of product types break down by years or quarter. There are
numerous ways to chart three or more dimensions of data. You can project data into the third
dimension of space. You can also represent the data in two spatial dimensions.

● Viewing Three-dimensional Bar Charts

● Clustered Bar Charts

● Stacked Bar Charts

● Area Charts

● Stacked Area Charts

● Line Charts

● Time Aware Axis

● Ribbon Charts

● Bar-Line (Combination) Charts
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Viewing Three-dimensional Bar Charts
You can add more information to your bar chart by adding an additional item or items to the z
axis of the chart. Using multidimensional charts, you can show various relationships between
three or more items in easy-to-understand bar chart formats.

Clustered Bar Charts
Cluster bar charts can be used to juxtapose categories in one label item category. For example,
use clustered bars to compare stores of different types. luster bars can also be used to compare
two different value items, such as Amount of Sales and Unit sold.

You can change your chart perspective so that the z axis data extended in the third dimension
is shown as clusters displayed in the foreground. This charting type is useful when z axis bars
are hard to distinguish in standard bar formats.

Cluster charts can be used to juxtapose categories in one label item. For example, use clustered
bars to compare stores of different types. Alternatively, cluster bars can also be used to compare
two different value items, such as Amount of Sales and Unit Sold.

Clustered bar charts are only displayed in a vertical format.

Stacked Bar Charts
One way to represent the third dimension of data is through stacking. In this way, a single bar
on the chart can show data for more than one category of data. For example, a single bar can
represent amount of sales for CD-ROM drives in one year on top of a bar representing sales for
other years. Stacked bar charts can stack vertically or horizontally.

The following is an example of a vertical stacked bar chart.
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The following is an example of a horizontal stacked bar chart.

Area Charts
Area charts are essentially bar charts with discontinuous breaks removed along the horizontal
axis. Data is not broken into discrete bars, but is displayed in a continuous ebb and flow as
defined against the y axis. Consequently, area charts are particularly useful for emphasizing the
magnitude of change over time. In addition, area charts can be used for the same purpose as bar
charts.

Because area charts do not break data along the horizontal axis, they are most useful for charting
three dimensions of data. The z axis should be used to either project data into a third-spatial
dimension, or to track two categories of data in a stacked area chart.

In the area chart, items in the y pane determine the height of the line, and items in the x pane
itemize the line sections. You can create multiple lines by adding items to the z pane.
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Stacked Area Charts
Stacked area charts are essentially bar charts with the discontinuous breaks removed along the
horizontal axis, and categories of data are “stacked” on top of each other. Data therefore is not
broken into discrete bars, but is displayed in continuous ebb and flow as defined against the y
axis. A stacked area chart is an excellent way to display data that shows the relationship of parts
to the whole. Consequently, stacked area charts can be particularly useful for illustrating changes
that are plotted over a period of time.

Line Charts
Line charts show trends in data at equal intervals and are effective for comparing highs and lows
in a continuum. Items on the y axis determine the height of the line, and items in the X-Categories
itemize the line sections. You can create multiple lines by adding items to the Z-Category.

Line charts have one advantage over bar charts. They do not enable one set of data to obstruct
the representation of another. Since lines are thin compared to bars, the data displayed in the
front does not block out the data behind.

As a result, data that is not easily represented in bar or area charts work well in line charts. Many
more dimensions of data can be superimposed without impairing the effectiveness of the chart.
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Time Aware Axis
The Time Aware Axis feature allows you to show dates in chronological order plotted at specific
intervals within minimum and maximum bounds. To do this, the Time Aware Axis feature turns
a discrete X-Axis into a continuous time interval. The distance between adjacent axis items is
proportional to their time value difference (a non Time Aware Axis shows all items using the
same difference between them). The Time Aware feature only implements an alternative
visualization of source data and does not affect the way how the data is aggregated and computed
items are calculated. That is, the data processing in chart section which includes dividing data
into categories and calculating fact data does not depend on whether the Time Aware feature is
activated. In particular, the behavior of the “Chart This Pivot”, “Pivot This Chart” and “Add
Computed Item” actions do not change.

The Line Charts is the main application area of this feature; however it is available in almost all
existing chart types. Scatter/Bubble charts do not include this option because they are already
“time aware” (essentially, value aware) by nature. Both have two fact axes which are continuous
by definition.

The Time Aware axis can only be used under specific conditions:

● The X axis should have a date/time category to display, which becomes a dedicated Time
Scale category.

● Only one category should be on the X-Axis. If you add multiple categories, even if they are
ate/time categories, the feature is rendered inactive.

● The Time Aware axis is not available for pie, scatter and bubble charts.

The Time Aware Axis is considered active if the conditions in the list above are met, and the
Time Aware option on the Label Axis dialog is not explicitly disabled. You can turn on or off
the feature. If you turn off the feature, the X axis remains discrete as in previous versions. By
default the feature is turned off for Interactive Reporting documents older than Release 9.3.
Charts created in Release 9.3 and later have the feature enabled.
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Note:

Since the Time Aware Axis assumes that all axis labels are in ascending order, the sort order
option is disabled.

➤ To create a Time Aware axis:

1 Check the Time Aware option on the Label Axis tab of General properties.

2 Drag a date/time item from the Catalog pane to the X pane in the data layout.

3 Drag a value item from the Catalog pane to the Facts pane in the data layout.

Ribbon Charts
A ribbon chart is very similar to a line chart, but with a few visual differences. In ribbon chart,
values in the y axis determine the height of the line, and values in the x axis itemize the line
sections. You can create multiple lines by adding items to the z axis.

Bar-Line (Combination) Charts
Bar-Line charts (also known as Combination charts) combine some of the strengths of bar charts
with the advantages of line charts. Solid bars can be used for the most important data against
which other dimensions are represented in lines. In this way, emphasis is give to a portion of
data based on its importance. A combination chart is especially useful for comparing two
numeric values, such as amount and units of sales.
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Note:

A combination chart is most effective when the y axis contains only two value items. It represents
one value as bars and the other value as a line. When more than two values are present, the chart
alternates between bars and lines in depicting the values (1st, 3rd, 5th items are bars; 2nd, 4th,
6th items are lines).

Working with Charted Data
Interactive Reporting provides several ways for you to dynamically manage your chart data for
better analysis. Review the following topics for information on:

● Adding Chart Items

● Removing Chart Items

● Focusing and Hiding Charted Data

● Grouping and Ungrouping Chart Labels

Adding a Chart

➤ To create a Chart based on the Results section data:

1 Select Actions > Insert > Chart.

2 Drag Results items from the Catalog List to the Chart Data Layout.

The table columns are populated automatically.

3 Select a Chart type on the shortcut menu.

Adding Chart Items
Interactive charts consist of two layout elements: graphical elements (for example, Chart bars
or pie slices) and axis labels. When you add items to a chart, they become values or dimensions
in your report.
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➤ To add a chart item:

1 Select a Chart item and choose Add item on the shortcut menu.

The x axis, y axis and z axis submenus are displayed. The z axis submenu does not display for a
pie chart.

2 Select a data label from the x axis submenu.

3 Select a fact item from the y axis submenu.

4 Select a data label item from the x axis (or Z-Cluster for a clustered chart, or Z-Stack for a stacked chart)
submenu to add a third dimension to the chart.

Removing Chart Items
Removing a plotted items in the Chart sometimes helps to simplify a chart display. However,
you do need at least one fact item in order to display a chart accurately.

➤ To remove a chart item:

1 Select the item to be removed in the Chart from the Data Layout.

2 Select Delete on the shortcut menu.

The chart is redrawn to reflect the new configuration of items in the chart.

Refreshing Chart Values Manually
If a Chart section has been designed so that chart values can be refreshed manually, you can
request an immediate refresh to the current section.

➤ To refresh chart values manually, click anywhere on the chart and selectRefresh Chart on the
shortcut menu.

Focusing and Hiding Charted Data
A straightforward way to refresh your view of a chart is to single out items for closer focus or to
hide some of the charted elements. This allows you to concentrate on particular items of interest.

Focusing redraws the chart report to show only the item you have chosen. This feature is only
available for items on the x axis or z axis.

The Show All command updates the chart to include all items removed by focusing. Note that
this command is available only when a Chart item has been focused.

Generally, you should only hide items on the x or z axis. Hiding the y axis causes the entire fact
to be hidden.

The Show Hidden Items command restores any hidden item.
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➤ To focus on a chart item:

1 Select one or more item on which to focus.

The selected items are displayed with a dotted outline.

2 Select Focus on the shortcut menu.

The chart is redrawn to display only the chart item selected.

➤ To show all items in a chart, select a chart item and choose Show Hidden on the shortcut menu.

➤ To hide charted data:

1 In the Chart, select the objects to hide.

The selected item(s) are displayed with a dotted outline.

2 Select Hide Item on the shortcut menu.

The chart is redrawn to hide the item.

➤ To show hidden items, select a chart item and choose Show Hidden on the shortcut menu.

Grouping and Ungrouping Chart Labels
You can merge Chart axis labels using the Group feature. When combined, the data associated
with labels is aggregated, creating a new summary label category. With grouping, only your view
of the data is changed. You can easily ungroup grouped categories and return to your original
label values.

For example, your chart report is structured with data item Units (sold) dimensioned by Year
and Quarter. You can group the first and second quarters together to summarize activity for the
first half of the year. The data is aggregated in a new label.

This feature is available only for items on the x axis or z axis.

➤ To toggle the group axis labels feature:

1 Select the individual labels to be grouped.

(You can group contiguous or discontiguous labels, but the labels must be part of the same
dimension item or axis.)

2 Select (Un)Group Items on the shortcut menu.

The selected labels, and their associated data values or chart objects, are combined. The resulting
label is displayed with an asterisk (*) to indicate a grouping.

To ungroup items, reselect the grouped items and choose (Un)Group Items on the shortcut
menu.
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Working with Chart Facts
Data functions in the Chart section are particularly useful if you want your report to display
different types of values. Data functions summarize groups of database records and replace the
original values with new summary data.

For example, in the Pivot section, you can show either the total sale, average sale, or the maximum
sale of each product by quarter. Each of these dimensions is based on the same underlying values.
They differ only in the data function that is applied.

The following table shows the Chart Functions:

Table 62 Chart Data Functions  

Data Function Returns the:

Sum Sum of all underlying values.

Average Average of all underlying values.

Count Number of underlying values.

Count Distinct Number of distinct values in a column.

Maximum Highest of underlying values.

Minimum Lowest of underlying values

Perc of Grand Sum of underlying values as a percentage of all surface values in the report.

NonNullCount Number of underlying values; null values are excluded.

➤ To apply a data function:

1 Select a bar or row of facts (such as Amount).

2 Select Data Function on the shortcut menu.

A shortcut menu of available data functions is displayed.

Optional: You can also select the item or column and choose Actions > Data Function, and
select the (function).

3 Select the function.

Each column is recalculated according to the data function applied to the underlying value.

Paging Through the Chart
By default Interactive Reporting shows a fixed number of rows in a table when a user views a
page in a browser. Often data extends beyond the vertical and horizontal rows shown on the
page. To view your paging options, see the table below.
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Table 63 Chart Paging Options  

Paging Option Description

Current Page Tooltip shows the current page.

Page Left Moves one view in the left direction. To move to the first view in the left direction, select [Shift] +
Click + left arrow.

Page Up Moves one view up in the Chart sections. To move to the top view, select [Shift] + Click + Up.

Page Down Moves one view in the down direction. To move to the first view in the down direction, select [Shift]
+ Click + Down arrow.

Page Right Moves one view in the left direction. To move to the first view in the right direction, select [Shift] +
Click + right arrow.

Pivot Section
Pivot tables are analytical tools that resemble spreadsheets or crosstab reports. Data can be sliced
and diced for ad-hoc, interactive and multidimensional analysis. You can pivot your data at any
time to change the way you view it, or you may drill down, or drill to detail to see how it all adds
up or summarizes. Pivot tables also allow you to add, move, focus on and group dimensions to
gain customized views of the data.

● Pivot Table Components

● Working with Pivot Data

● Focusing and Hiding Pivoted Data

● Working with Row and Column Labels

● Analyzing Pivot Data

● Working with Pivot Facts

● Paging Through Pivot Data

Pivot Table Components
A pivot table is composed of three components:

● Facts – The numeric values broken up in the body of the pivot table. Facts may also be
referred to as data values.

● Data Labels – The column and row headings on the top and sides of the Pivot and define
the categories by which the numeric values are organized.

● Dimensions – A full row or column of labels.
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Working with Pivot Data
Interactive Reporting provides several ways for you to dynamically manage your pivot data for
better analysis:

● Adding a Pivot Section

● ???

● Deleting Pivot Items

● Auto-Sizing a Column

● Focusing and Hiding Pivoted Data

● Swinging Pivot Dimensions

● Grouping and Ungrouping Pivot Labels

Adding a Pivot Section

➤ To create a table based on the Results section data:

1 Select Actions > Insert > Pivot.

2 Drag items from the Catalog list to the Pivot Data Layout.

If the Data Layout is not displayed, select View > Data Layout.

Interactive Reporting populates the cells, rows and columns automatically.

Adding Pivot Items
You can add items from the Results set to view and analyze different scenarios in your Pivot.

➤ To add a pivot item:

1 From the Catalog list, select any item and click Add Items on the shortcut menu.

A shortcut showing Row, Column or Facts is displayed.

2 Select the value you want to add.

Deleting Pivot Items

➤ To delete a pivot item:

1 Select the item to be removed from the Facts, Rows or Columns Data Layout.

2 Select Delete on the shortcut menu.

The Pivot is redrawn to reflect the new configuration of items.
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Refreshing Pivot Values Manually
If a Pivot section has been designed so that pivot values can be refreshed manually, you can
request an immediate refresh to the current section.

➤ To refresh pivot t values manually, click anywhere on the pivot and selectRefresh Pivot on the
shortcut menu.

Auto-Sizing a Column
By default, Interactive Reporting truncates columns evenly and without regard to the length of
data values. With the Auto-Size Column Width feature, you can automatically size any column
to fit the text of the largest value in the column.

➤ To autosize a column:

1 Select the column.

2 Select Auto-Size Column Width on the shortcut menu.

Focusing and Hiding Pivoted Data
A straightforward way to refresh your view of a pivot table is to single out items for closer focus
or to hide some of the pivot elements. This allows you to concentrate on particular items of
interest.

Focusing redraws the pivot table to show only the item you have chosen to focus on.

The Show All Items command updates the pivot table to include all items removed by focusing.
This command is available only when a pivot dimension label has been focused.

Hiding columns is a good way to temporarily suspend the display of a column.

➤ To toggle the focus on a pivot item:

1 Select one or more dimension labels (either side or top).

2 Choose Focus on the shortcut menu.

The Pivot is redrawn to display only the chart object selected.

➤ To show all items, select a dimensional label and choose Show All on the shortcut menu.

➤ To hide pivoted data:

1 Select an item.

2 Select Hide Items on the shortcut menu.

The Pivot is redrawn to hide the selected object.
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➤ To restore a selected hidden item, select a pivot item and choose Show Hidden on the shortcut
menu.

Working with Row and Column Labels
Row and column labels can be grouped and reoriented:

● Grouping and Ungrouping Pivot Labels

● Swinging Pivot Dimensions

Grouping and Ungrouping Pivot Labels
You can merge pivot labels using the Group feature. When combined, the data labels are
aggregated, creating a new summary label category. With grouping, only your view of the data
is changed. You can easily ungroup grouped categories and redisplay original label values.

For example, your pivot table is structured with data item Units (sold) dimensioned by Year
and Quarter. You can group the first and second quarters together to summarize activity for the
first half of the year. The data is aggregated in a new label.

➤ To toggle the group dimensional label feature:

1 Select the individual labels to be grouped.

(You can group contiguous or discontiguous labels, but the labels must be part of the same
dimension item or axis.)

2 Select (Un)Group Items on the shortcut menu.

The selected labels, and their associated data values or chart objects, are combined. The resulting
label is displayed with an asterisk (*) to indicate a grouping.

To ungroup items, reselect the grouped items and choose (Un)Group Items on the shortcut
menu.

Swinging Pivot Dimensions
The swing feature allows you to re-orient the axes of a pivot table and view your data in new
ways. When you “swing” a dimension, you can move it up, down or to the opposite axis. This
feature is a powerful tool that makes pivot table reporting more powerful than a common
spreadsheet.

Note:

You can swing pivot dimensions by moving items within and between Data layout panes,

➤ To swing a dimensional label:

1 Select a dimensional label and choose Swing on the shortcut menu.
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2 Select a direction.

Valid swing positions are:

● Vertical

● Horizontal

● Up

● Down

● Left

● Right

● Before

● After

If you select the “before” swing positions, you must choose the dimension label before which
you wish to place the selected label. This behavior applies to the “after” selection as well.

Working with Pivot Facts
Core numeric data that you slice and dice dimensionally in your analysis are called facts. Facts
can be summed to create totals.

You can calculate totals for both columns and rows in a Pivot report. If you layered dimension
items along the top or side labels of your report, you can calculate the totals for any level in the
hierarchy. When you select an inner dimension for totaling, subtotals are created for each of the
categories in the outer dimensions. Totals in the Pivot section include:

● Total Function

● Cumulative Totals

● Surface Values

Total Function
You can quickly add totals to your pivot table data. The new total value is created as an additional
column. Total functions can be applied to:

● Underlying values from the original results sections

● Surface values displayed in the Pivot

Depending on which set of values you apply the total function, different results are yielded.
Consider a simple pivot table with two values of 20 and 30. Each of these is already a total of
underlying values (20 = 8 +12 and 30 = 10 + 20). An average of the underlying value yields the
result of 12.5 = (8 + 12 + 10 + 20) /4). An average of the surface values yields the results 25 =
(20 +30) / 2).

➤ To add totals to a Pivot:

1 Click a row or column label handle to select it.
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Selecting the outermost label creates a total; selecting an inner label creates a subtotal.

2 Select Add Total on the shortcut menu.

A submenu of data functions is displayed.

3 Select a data function.

Cumulative Totals
By adding cumulative running totals to a pivot table, you can break totals by dimension to restart
at each dimensional grouping in the report.

➤ To add a cumulative calculation:

1 Select a fact item in the data grid of the Pivot.

2 Select Add Cume on the shortcut menu.

The Add Cume shortcut menu is displayed.

3 Select a scope from the Add Cume shortcut menu.

A new data values item named “Cume of X” is displayed across each row of the report. The new
cume item maintains a cumulative running sum of the original data values item.

Note:

Cumulative totals are most effective when all dimensions are located on a row or column of the
report, and data label column heads are placed orthogonally.

➤ To modify a cumulative calculation:

1 Select a column in which a cume has already been place in the pivot table’s data grid.

2 Select Modify Cume on the shortcut menu.

The Modify Cume submenu is displayed.

3 Select a scope from the Modify Cume shortcut menu.

Surface Values
You can use underlying or surface values when working with totals in Pivot sections. Underlying
values refer to values from the original results section. Surface values refers to values in the actual
report section. The two approaches yield different results, and produce values that may be
displayed incongruous with the values in the report.

To understand this difference between underlying and surface values, consider a simple pivot
table with two values of 20 and 30. Each of these is already a total of underlying values (20 = 8
+12 and 30 = 10 + 20). An average of the underlying value yields the result of 12.5 = (8 + 12 +
10 + 20) /4). An average of the surface values yields the results 25 = (20 +30) / 2). By default,
the surface value feature is not active.
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➤ To activate surface values, select a pivot item and Surface Values on the shortcut menu.

Analyzing Pivot Data
Data functions in the Pivot section are particularly useful if you want your report to display
different types of values. Data functions summarize groups of database records and replace the
original values with new summary data.

For example, in the Pivot section, you can show either the total sale, average sale, or the maximum
sale of each product by quarter. Each of these dimensions is based on the same underlying values.
They differ only in the data function that is applied.

Table 64 Pivot Data Functions 

Data Function Returns the:

Sum Sum of all underlying values.

Average Average of all underlying values.

Count Number of underlying values.

Count Distinct Number of distinct values in a column.

Null Count Number of nulls among underlying values.

Non-Null Count Number of underlying values; null values are excluded.

Maximum Highest of underlying values.

Minimum Lowest of underlying values

% of Row Sum of underlying values as a percentage of their respective surface row.

% of Column Sum of underlying values as a percentage of their respective surface column.

% of Grand Sum of underlying values as a percentage of all surface values in the report.

➤ To apply a data function:

1 Select a row or column of facts (such as Amount).

2 Select Data Function on the shortcut menu.

A shortcut menu of available data functions is displayed.

Optional: You can also select the item or column and choose Actions > Data Function, and
select the (function).

3 Select a function.

Each column is recalculated according to the data function applied to the underlying value.
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Paging Through Pivot Data
By default, Interactive Reporting shows a fixed number of rows in a table when a user views a
page in a browser. Often data extends beyond the vertical and horizontal rows shown on the
page. To view your paging options, see the table below.

Table 65 Pivot Paging Options  

Paging Option Description

Current Page The tooltip shows the current page in the report.

Page Left Moves one page in the up direction. To move to the top page, select [Shift] + Click + Up.

Page Up Moves one page in the down direction. To move to the first page in the down direction, select [Shift]
+ Click + Down arrow.

Page Down Moves one page in the left direction. To move to the first page in the right direction, select [Shift]
+ Click + right arrow.

Page Right Moves one page in the left direction. To move to the first page in the left direction, select [Shift] +
Click + left arrow.

Common Chart/Pivot Features
Interactive Reporting document management features allow you to easily tailor the look of
reports. The features shown below are common in the Chart and Pivot sections:

● Sorting Charts/Pivots

● Drill Anywhere into Charts/Pivots

● DrillDown into Dimensional Data

Sorting Charts/Pivots
In the Chart and Pivot sections, data is sorted alphabetically. You can override this default and
sort dimensional data with reference to other data, rather than alphabetically.

For example, if a chart lists each type of item your company sells and the total amount sold of
each, initially the item types are alphabetically ordered. But this data becomes more meaningful
when you instead sort the item types with reference to the total sales revenue produced by each.
This approach allows you to rank each product type from highest to lowest total sales.

When you want to apply a sort criteria there are three components used to define the sort
condition:

● Sort Items – Consists of those items that can be sorted in ascending or descending order. In
the Chart section, sort items refers to the chart axes. In the Pivot section, sort items refers
to the pivot dimensions.
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● Referential Items – Refers to the numeric data item included in the Chart or Pivot section,
and also the keyword “labels.” These selections provide two ways to sort the selected Chart
or Pivot item.

❍ Sorting by labels – Dimensional data items are sorted alphabetically by name when the
chart section is created: this is equivalent to sorting by “labels.” When selected, the
“labels” keyword simply indicates that the item chosen from the submenu are sorted by
label or name, rather than by reference to corresponding numeric data values in the
report.

❍ Sorting by values – Sorting by a numeric data item orders each value of the target item
specified by its corresponding numeric value in the second list. Sorting by values
produces an entirely different sort order. For example, your chart may list each state in
which your company has made sales revenue and the total cost-of-sales for each. The
data items are initially listed in alphabetical order, that is, sorted by “labels.” When you
sort instead by cost-of-sales, the states are ranked in order by each corresponding cost-
of-sales figure.

● Functions – Refers to aggregate statistical functions available when you sort by values. The
functions generally duplicate the data functions available in the chart section.

When you sort by values, dimensional data is sorted by the corresponding numeric values of the
referenced item. (For example, sorting states by the sum total of the cost of good sold in each
state).

➤ To specify a sort:

1 Select an item to sort in the Chart or Pivot sections.

2 Click either Sort Ascending or Sort Descending on the shortcut menu.

3 Select Label to sort the item alphabetically, or select the numeric value item as a sort reference.

4 If you selected a numeric value, choose an aggregate function on the shortcut menu.

Drill Anywhere into Charts/Pivots
The Drill Anywhere feature allows you to drill into and add items in the Chart and Pivot sections
that are resident in the Results section, but have not been included in the Chart and Pivot you
are viewing. Drill anywhere items are broken out as a new label item(s) automatically. The
advantage of this feature is that it instantly allows you to add items to the data set to reflect
temporary and hypothetical situations.

The extent to which you can drill into your data depends on how the original query was built,
since Drill Anywhere retrieves data from the Results section.

➤ To drill anywhere into a Chart:

1 Select a pivot dimension or chart item for analysis.

2 Select Drill Anywhere on the shortcut menu.

A shortcut of drill anywhere items displays.
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3 Select an item on which to drill down.

The report is redisplayed, breaking out the additional data as a new label item.

Note:

If no options are available in the Drill Anywhere drop down list, all available items have been
referenced in the chart.

DrillDown into Dimensional Data
The DrillDown feature enables you to use a predefined drill-down path to go directly to the next
item in a hierarchy when working with dimensional analysis. For example, you may need to find
out if a particular product sells better in different regions of the country. Using a drill-down
path, all you have to do is follow the drilldown path to discover which state or even city is a more
appropriate market for your product.

➤ To drill down into a Pivot or Chart label:

1 Select any label for drill-down analysis.

Because the drill-down into feature is not context sensitive, access the drill-down from any label
shown.

2 Click Drilldown into on the shortcut menu.

All available drill-down paths are displayed. Each drill-down path shows the topic which is being
drilled into, and the label from which it was drilled.

3 Click the drill-down label.

After you specify the drill down label, the label is added to the Data Layout and breaks out the
additional data according to the label selected for drill-down.

➤ To drill up from data:

1 Click the label that has been drilled downed.

2 On the Pivot or Chart menu, select Drill Up.

The report is redisplayed, reversing the drill-down and displaying the original item.

●

●

280 Interactive Reporting




